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1. Uvod – Adobe Photoshop

U današnje vrijeme računala imaju veliku primjenu u pohrani i obradi slika u raznim formatima. Padom cijena digitalnih fotoaparata i skenera sve više slika se pohranjuje u digitalnom obliku na računalu. Računala su postala nezamjenjiv alat za obradu i retuširanje fotografija.
Web je nezamisliv bez slikovnog sadržaja, zauzima značajno mjesto u prezentiranju i oglašavanju poduzeća i ustanova. Slike koje se prezentiraju na Web-u potrebno je obraditi i pohraniti u formatu prikladnom za prikaz i prijenos preko Interneta. 

Adobe Photoshop
Photoshop CS2 je softver namijenjen za rastersko obrađivanje digitalnih fotografija. Trenutno je vodeća inačica svjetske aplikacije za obradu slika. Web dizajneri mogu se pouzdati u kompletnu povezanost Photoshopa i ImageReady aplikacije kod kreiranja web grafike s izvrsnim eksportom za web i alatima za razrezivanje većih slika. Kreirajte kompletan homepage u tablici s rolloverima i animiranim gifovima. Photoshop donosi, naravno, i ogromnu količinu alata za obradu slike za ekransku ili papirnatu uporabu.
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 Adobe Photoshop                               
Izdavač: Adobe Systems

Zadnja verzija: CS2 (9.0.2) / 4. april 2005
OS: Mac OS X i Microsoft Windows
Vrsta: Grafički alat

Licenca: Vlasnički softver

Website: www.adobe.com/products/photoshop
Adobe Photoshop na Mac OS X operativnom sistemu
Adobe Photoshop je softver namijenjen za rastersko obrađivanje digitalnih fotografija. Trenutno je vodeći grafički alat i namijenjen je za korištenje na Microsoft Windows i Apple operativnim sistemima. Kompanija zaslužna za Photoshop se zove Adobe Systems.

Prva verzija ovog profesionalnog alata je izašla u februaru 1990. godine i to samo na Mac OS platformi. Korisnici Windowsa su tek s verzijom Photoshop 2.5, koja je izašla u novembru 1992. godine, dobili pristup ovom programu.

U proteklih nekoliko godina, popularnost Photoshopa je dovela do stvaranja nove Internet skraćenice - fotošopovati (en. to photoshop something). Riječ se koristi u smislu izmjene fotografije za pogodne svrhe (internet, e-mail, šala). Photoshop je konstuiran na takav način da može nesmetano surađivati s drugim programima Adobe kompanije, npr. Adobe InDesign.
Imate sliku koju želite iskoristiti za web, album ili ju jednostavno printati ali vam se čini da je prilikom unosa u računalo (putem skenera, digitalnog fotoaparata, kamere i sl.) izgubila na kvaliteti? U idućih nekoliko koraka bit će objašnjeno kako se koristiti Adobe Photoshop. Photoshop je jedan od boljih programa za obradu, izradu i optimizaciju rasterskih slika. Da bi se bolje upoznali s njegovim mogućnostima treba shvatiti neke temeljne pojmove. Rasterski program znači da se radi o programu koji slike predočava pomoću točkica ili piksela. To je veličina koja nije direktno povezana s tiskom. Ono što je nama bitno je da znamo razliku između piksela i DPI-a. 
2. Obrada digitalne slike

Obrada digitalne slike je postupak mijenjanja detalja na nekoj digitalnoj fotografiji. Za tu svrhu se koriste posebni programi koje nazivamo vektorski i rasterski grafički softver koji služe kao alat za mijenjanje, štimanje, poboljšavanje i razmjeranje slike. Obrada digitalnih slika se koristi u nauci, medicini i forenzici.
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Osnove obrade 

Rasterske slike se u računaru pohranjuju kao mreže piksela. Pikseli sadrže informacije o boji, svjetlini i ostalim postavkama neke digitalne slike. Grafički programi mogu mijenjati te piksele, odnosno čitave slike, da bi se neka digitalna slika promijenila ili poboljšala na mnogo načina. Za to služe rasterski grafički programi, dok imamo i vektorske grafičke programe koji su više stvoreni za pravljenje novih i drukčijih slika u vektorskoj grafici.

2.2. Grafički programi 

Postoji čitav niz raznih grafičkih programa, od onih jednostavnih (kojima je moguće vršiti okretanje ili razmjeranje slike) pa sve do detaljnih programa koji imaju jako detaljne algoritme sa mnogo opcija za rukovanje digitalnom slikom. Poznati rasterski grafički programi su Adobe Photoshop, Paint Shop Pro i potpuno besplatni GIMP.

2.3. Sažimanje digitalne slike 
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Mnogi formati slika koriste tehniku sažimanja za smanjivanje veličine grafičkog podatka. Primjer sažetog formata je JPEG format koji pokušava smanjiti veličinu podatka uz neprimjetne gubitke kvalitete slike što uvijek nije slučaj (zavisi od nivoa sažimanja). Postoje i algoritmi sažimanja koji ne umanjuju kvalitet slike, takav je PNG format. Veoma često se prave kompromisi na ovom polju, tako da se na internet obično postavlja sažeta grafika koja je često slabijeg kvaliteta nego original.

2.4. Mogućnosti grafičkih programa 

Ispod ćete vidjeti neke najpoznatije mogućnosti koji mogu izvoditi grafički programi nad digitalnim slikama.
2.5. Označavanje dijela 
Označavanjem jednog dijela slike te radom na tom dijelu ne utječe na ostatak slike Osnovna funkcija svakog grafičkog programa je mogućnost odabira ili isjecanja označenog dijela slike. Tako je moguće napraviti promjene na samo jednom dijelu slike koji neće utjecati na čitavu sliku. Postoji nekoliko alata pomoću kojih se ovo radi, to su marqee alat, lasso, virtuelne olovke, maskiranje, alfa sačinjavanje, kanalno-bazirano vađenje, kao i vađenje na osnovu boje.
2.6. Slojevi 
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Jedna od važnijih osobina svakog grafičkog programa jesu slojevi (layer). Doslovno jedan grafički program može imati neodređeni broj slojeva od kojih se sačinjava cjelina odnosno slika. Grafički program je u mogućnosti sakriti jedan sloj slike, promjeniti samo jedan da ne utječe na drugi, te stopiti dva sloja u jedan, grupirati ih i tako dalje. Ovo je jedna od najvažnijih mogućnosti jer omogućuje lagano i efikasno rukovanje slikom bez da se učini neka nepovratna akcija koja će uništiti cijelu sliku. Također je moguće dodatno isprobavanje raznih efekata i promjena bez diranja same slike, taj se sloj kasnije može ukloniti ili ostaviti, ovisno o kvaliteti kako je odrađen.

Prikaz rada sa slojevima u grafičkom programu Photoshop, pokazane tehnike stopljavanje jednog sloja sa drugim kao i sakrivanja pojedinog sloja.
2.7. Mijenjanje veličine 

Skoro sav grafički softver može mijenjati veličinu ili rezoluciju neke slike. Većinom se to koristi kod smanjivanja slika koje su velike rezolucije, jer nema smisla postavljati veliku sliku na internet jer se u protivnom slika sporije učitava kod korisnika sa sporijom vezom, a i sama slika je nepregledna jer prelazi dimenzije monitora i njegove prirodne rezolucije. U uređivanju grafike nekih novina ili časopisa zahtjeva uvećavanje slike, jer pikseli nisu iste jedinice kao uobičajene metričke (kao što je centimetar). Za obični A4 papir koji se koristi u časopisima je potrebna računarska rezolucija od 2480x3508, kao i prateće slike i grafika u većim rezolucijama nego što smo navikli, zbog toga veličina takvih dokumenata (jedne stranice) iznosi skoro 50 Megabajta u svom orginalnom formatu. Zato grafičari cijene digitalne fotoaparate koji mogu proizvesti veću sliku, što se očitava u megapikselima (mpx), a nerijetko se događa da je fotoaparat u nemogućnosti proizvesti dovoljno veliku sliku pa se slika dodatno uvećava u grafičkom programu što umanjuje kvalitet slike.
2.8. Izdvajanje dijela 
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Pomoću grafičkih programa moguće je doslovno izrezati dio jedne slike koji će kasnije i sam postati nezavisna slika. To se koristi i kod rezanja neželjenog dijela jedne slike. Pomoću ove 
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     slike
2.9. Histogram 

Grafički programi imaju i slikovni histogram neke digitalne slike. Histogram prikazuje vrijednost osvijetljenja pojedinačnog piksela. Algoritmi u grafičkim programima omogućuju štimanje svjetline svakog piksela. Tako je moguće postići bolje rezultate i kvalitet slike.
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Histogram

2.10. Otklanjanje nečistoća 

Grafički programi su u nekoj mjeri u mogućnosti otkloniti smetnje sa neke slike. Najčešće takve slike bude popunjene takozvanim točkicama (noise) koje su rezultat slikanja u slabom osvijetljenju. 
2.11. Uklanjanja neželjenih dijelova 
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Pomoću grafičkih programa moguće je ukloniti neželjene dijelove neke slike, koristeći se "clone" alatom ali i pomoću ručnog samostalnog rada.
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Uklonjeno grmlje sa  vrha   slike
2.12. Promjena određene boje 

Grafički programi mogu promjeniti određenu boju nekog predmeta u slici.
[image: image19.jpg]


Primjer mijenjanja određene boje, orginalne koja se nalazi na desnoj strani

2.13.Položaj slike 

Grafički programi su u mogućnosti narediti da se slika okreće u bilo kojem uglu i položaju. Slike se mogu prevrtati i preslikavati. Također moguće ih je i okretati, te im mijenjati perspektivu.




Primjeri okretanja slike
2.14. Spajanje slika 

Moguće je spajati više nezavisnih slika ili dijelova slika u jednu cjelinu.




John i Bertha Phillips – 1910.
2.15. Specijalni efekt 

Skoro svi grafički programi mogu stvarati neke specijalne i neobične efekte koje rezultiraju zanimljivim ishodima. Program može primjeniti umjetničke, geometrijske, teksturne itd. efekte.
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              Primjer specijalnih efekta koji se mogu  

              dodati na sliku ili sloj

2.16. Mijenjanje dubine boje 

Moguće je i promijeniti dubinu boja, najčešće su one sa 2, 16, 256 boja, te one sa 16 miliona boja. JPEG i PNG slike su u mogćnosti imati 16,7 miliona boja. Također je moguće pretvoriti sliku u 8 bitnu - crnobijelu.
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          Primjer pretvaranja slike u crnobijelu 
2.17. Kontrast i svjetlina 

Ove opcije imaju i najjednostavniji grafički programi, pomoću njih se povećava ili smanjuje svjetlina ili kontrast neke slike.

2.18. Izoštravanje i glađenje 

Pomoću grafičkih programa je moguće izoštravati i mutiti sliku na više načina. To se koristi kod glađenja portreta, odnosno pozadinu portreta da bi se osoba na slici istakla. Veoma je lako i odstranjivanje efekta crvenog oka.
2.19. Štimanje boja 

Štimanje boja je jedna od najosnovnijih opcija, pomoću ove tehnike se može unaprijediti kvalitet slike kao njen tonski balans. Imamo i komplikovanije procedure kao što je miješanje boja.
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2.20. Dimenzioniranje 

Nakon što smo učitali sliku treba odrediti da li želimo zadržati cijelu sliku, ili rezati neki njen dio. To činimo sa Crop tool-om. On nam omogućuje da izrežemo željeni dio slike. Slijedimo sljedeće korake: odabiremo Marquee tool ili se za odabir koristimo tipkom ''M''. 
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Nakon toga kliknemo na sliku tamo gdje želimo da nam bude jedan kut slike te držeći tipku miša povlačimo do suprotnog željenog kuta. Onda pustimo tipku. Time smo označili željeno područje. Sada ga režemo van pomoću Crop tool-a. 

 
2.21. Veličina slike 
Veličinu slike određujemo izbornikom koji pokrenemo na Image>Image Size. 
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S ponuđenim opcijama možemo sliku povećati, smanjiti i sl. Opcija Constrain Proportions će omjer visine i širine slike uvijek držati konstantnim ako je uključena. Pixel Dimensions je veličina u pikselima na ekranu dok se Document Size odnosi na imaginarnu veličinu, npr. kolika će se slika isprintati. Klikom na OK potvrđujete parametre koje ste unijeli. 
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2.22.Boje 
Izbornik boja pokrećemo na Image>Adjustments. 
Ako je slika u boji, boju možemo izmjenjivati u istom izborniku pod Color Balance. 
Ponuđeno nam je igranje s količinom osnovnih boja. Pomicanje strelice na liniji za željenu boju određuje se intenzitet te boje i time postiže željeni efekt. 
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U istom izborniku nalazimo i opciju Desaturate koja pretvara sliku u boji u crno-bijelu. Često se koristi izbornik Brightness/Contrast, također u istom izborniku. 

Brightness određuje koliko je slika tamna/svijetla. Contrastom određujemo razliku izmedu svijetlog i              tamnog. 

2.23. Spremanje
Nakon što smo obradili sliku potrebno ju je spremiti. Odabirom File>Save spremamo sliku. Prilikom spremanja je potrebno odabrati format slike (JPEG, GIF, TIFF...). Ako se radi o materijalu koji se koristi za web ili pokazivanje na monitoru izaberite JPEG. Ako se radi o materijalu za tisak potrebno ga je spremiti kao TIFF.
3. Adobe PhotoShop CS2 – mogućnosti

Digitalna tamna komora ili iluzija?
 
Već od nekad vrijedi, da fotografija nije gotova pritiskom na okidač, nego da se tek od onda stvara. U analognom svijetu još danas mnogo fotografa misli da je ono što su snimili na film konačna fotografija ili otisak. To je mišljenje uvijek bilo krivo jer je tada nastala samo "latentna", nevidljiva slika. Put do vidljive, te nadasve kvalitetne slike je bio još dug. 

Prvi moraju prije svega izgubiti strah pred novostima i mišljenje da je primjerenije upotrebljavati kemikalije. Odnosno, moraju spoznati, da nije ništa drugačije nego što je bilo. Fotografija još uvijek ostaje fotografija. Ali put do konačnog proizvoda je moderniji, moguće brži, u više izvedbi, jefitniji i naravno, kvalitetniji. Drugi, da saznaju što nam sve program za obradu fotografija nudi. Na taj način ćemo spoznati da li će nas "digitalna tamna komora" osvojiti ili ćemo obradu svojih fotografija prepusiti drugima. Čak i u tom slučaju, barem će saznati sve prednosti i mogućnosti programa i na taj način znati objasniti drugima što od obrade fotografije očekuju. Još važnije je da spoznamo što nam "digitalna tamna komora" uopće omogućuje. A nudi nam vrlo, vrlo mnogo. Čak toliko da je pogled na fotografiju s klasičnog vidika posve pogrešan.

Tko pak želi program PhotoShop uopznati brže, na raspolaganju su mu tečaji programa u sklopu Digitalne Akademije (objavljeni na http://www.digitalna-akademija.com/).
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Program PhotoShop poznajemo već 18 godina. Posebne programe, koji su se upotrebljavali prije mnogo godina s bubanj skenerima (Hell - DaVinci) i nudili i više nego danas najnoviji PhotoShop CS2. Možemo tvrditi da program PhotoShop sada dobiva posve fotografska oruđa. Do sada je bio namjenjen u prvom redu za grafičku tehniku. 
Spoznati ćemo još nešto. I to je za sve korisnike analogne tehnike vrlo bitno. Program PhotoShop, a to je digitalna tamna komora, je u osnovi komora na svjetlu. Sve što nam je nudila klasična tamna komora, program PhotoShop nam nudi to isto pomoću drugačije tehnike obrade. Sada se tonske korekture, gradacija i razni efekti izvedu na drugačiji način. Istina je da su program pisali programeri, ali isto tako niti uređaj za povećavanje i ostalu opremu nisu napravili fotografi. Znajte pak da je uz programera sjedio stručnjak koji poznaje obradu fotografije. I klasične. I tako ćemo vrlo brzo spoznati da je "digitalna tamna komora" vrlo slična klasičnoj, te da je sada naša tamna komora umjesto kakave garaže, kupaone ili posebne sobe u kojoj su uređaj za povećavanje, kemikalije i posude za razvijanje, sada naš stol s računalom. Pored računala i programa PhotoShop, trebamo samo ekran gdje vidimo sva oruđa i miša s kojim ta oruđa upotrebljavamo.

U nastavcima ćemo upoznati i daljnji program PhotoShop-a CS2 od otvaranja i arhiviranja fotografija, preko osnovnih korektura, izreza, rotiranja, jednostavnih tonskih korektura, kako posegnuti u zahtjevnije tonske korekture, koje upotrebiti kod određenih zahtjeva, selektiranje određenih dijelova i mogućnost njihove obrade, oklanjanje smetajućih dijelova u slici, dodavanje slike u sliku ili samo dio motiva iz druge slike, kako interpolirati fotografije, dodatno ih izoštriti, pripremiti za osvjetljavanje u fotolaboratoriju ili ispis na pisaču i mnogo efekata koji nam omogućavaju dodatno mijenjati fotografiju obzirom na izraznu vrijednost.

Za početak si kod prikazanih fotografija možemo pogledati do kuda seže obrada fotografije.
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4. Zaključak
Adobe Photoshop je već dugo vodeći alat za obradu rasterske (bitmap) grafike. Trenutno je na tržištu njegova deveta verzija CS2 (Creative Suite 2) koja je u odnosu na prethodnu CS verziju donijela puno novosti. Inače, Photoshop je apsolutni standard za rastersku grafiku i više od 90% grafičkih profesionalaca ga koristi iz jednostavnog razloga: jednostavno nema dovoljno dobrog konkurenta.

Sučelje Photoshopa je ogledni primjer, ne samo za grafičke programe nego i za sve aplikacije koje imaju specifičnu namjenu. Fleksibilno je i intuitivno, sa prilagodljivim paletama i odlično pogođenim kontrolama (kombinacija miša i tipkovnice). Osim što je ogroman trud programera uložen u dizajn i ergonomiju sučelja, Photoshop je najnapredniji i u raznim optimizacijama i metodama korištenja procesora. Zbog svega toga, Photoshop se smatra najboljim grafičkim rješenjem za profesionalce.

Kao i svaki drugi program, Photoshop zahtjeva nešto vremena da se priviknete na njegovo sučelje, ali to vrijeme je puno kraće nego kod bilo kojeg drugog programa. Što se tiče mogućnosti manipulacije slikama, ne postoji stvar koja bi vam mogla pasti na pamet, a da se ne može izvesti u Photoshopu (ponekad i na više različitih načina). Osim što potpuno podržava rastersku (bitmap) grafiku, Photoshop ima i djelomičnu podršku za rad sa vektorskom grafikom.

S obzirom da je Photoshop de facto standard u rasterskoj grafici nema smisla opisivati njegove već viđene mogućnosti, niti ga uspoređivati sa konkurencijom. Dovoljno je reći da se je program opasno približio savršenstvu. Jedina mana mu je za amatere visoka cijena od 650 $ (ne i za profesionalce, kojima je on vjerojatno jedini realni izbor). Za zahtjevne fotografe koji si ne mogu priuštiti Photoshop možda je dobra alternativa program Photoshop Elements, koji ima dobar dio mogućnosti Photoshopa (ali nema podršku za neke naprednije stvari) i znatno nižu cijenu. Za Photoshop je moguće dati samo ocjenu 10/10.
Upoznajte“digitalnu tamnu komoru”, upoznajte što nam nudi program Adobe PhotoShop CS2 i biti ćete još korak bliže "novoj" fotografskoj revoluciji. Na taj način ćete izgubiti strah pred novom tehnologijom i nakon pritiska na okidač samim utjecajem na fotografiju.

Rasprave na pitanje da li je to “fotografija ili iluzija” prepustite onima koji digitalnu fotografiju još nisu prihvatili.
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Upoznati ćemo se s različitim načinima izrezivanja slike. To što je u klasičnoj komori bilo dugotrajan i vrlo precizan posao. S programom PhotoShop je sada to postalo mnogo jednostavnije. Digitalno nam nudi nevjerojatno jednostavnije mogućnosti.





S funkcijom "Extract" do brzih izreza.





Sve je u vašoj mašti! Otvorite joj put.





Program nam sve omogućava. Samo se morate barem djelomično s njim upoznati. U cijelosti je to skoro nemoguće. Uprkos tome što program PhotoShop koristimo već 18 godina, poznajemo ga dobro oko 30-ak %. Fotograf  treba znati samo negdje oko 10 posto. Većina funkcija je vrlo slična, da se mogu poistovjetiti s već poznatim.





Širokokutni objektivi nam brzo pokvare sliku. Linije počnu padati, kriviti se ili kako drugačije mijenjati oblik. Ali svakako fotografirajte. S dovoljno točaka zalihe, će vaše povećanje dobiti novu dimenziju.





Nema potrebe koristiti posebne“shift-tilt” objektive ili kamere s mijehom da bi promijenili nagib zahvata. Sada s pomoću programa u par sekundi poravnamo linije. Preporučljivo je uhvatiti nešto širi kut s većom količinom točaka.





Prozor "Lens Correction", kojim popravaljamo greške naših objektiva.








Popravljanje greške širokokutnih objektiva, "distorzija" i "padanje" linija.











Fotografirali su vas u zavidnoj situaciji, ali vas fotografija nije zadovoljila. Gdje ste na slici? Odnosno, da li je fotograf vrijedan "PRO" naziva ?





Ako je preveliki kontrast zavarao fotografa i nije vas do osvIjetlio s bljeskalicom, imate s programom mogućnost ipak se pokazati ! "Voila!"











U Programu PhotoShop možemo napraviti naslovnice knjiga, revija ....





Fotografije su uvijek pune neželjenih elemenata. U analognoj komori je s maskiranjem bilo mnogo posla. Samo rijetki su to probali i na razne popravke potrošili mnogo vremena.





Naši stari dijapozitivi s pomoću skenera i pretvorbe u digitalni zapis ponovno ožive. Pogrešno je mišljenje da je dijapozitiv jedini original. Još nekada smo ga popravljali, a danas je to samo lakše.














Sve kao u klasičnoj tamnog komori! A: maskiranje za probu pravilnog osvjetljenja u stupnjevima, B: tonska korektura, C: solarizacija, D: naglašena oštrina, E: C/B, F: naglašene osnovne boje, G: toniranje, H: kontrast, I: osvjetljenje tamnih dijelova ...
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